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Introduction

Using Microsoft Access Database is one of a valuable
and user-friendly new series of easy-to-read booklets
created specially to help you develop at work. The
materials have been created from actual experience in
workplace training. Experts from Workbase Training and
Campaign for Learning have pooled their knowledge and
experience to involve you in learning new skills and
building on those you already have. The booklet is divided
into clear sections, containing specially devised activities.
There are additional exercises at the end of the sections
to allow you to practise as you learn. You will need to
use a computer to carry out some of the activities.
Before you begin using this booklet, it is assumed that:

• you will have already received an introduction to the
computer

• you are familiar with the keyboard and you can use a
mouse to point, click, double-click and drag

• you are using Windows software.

Information
and skills you
will acquire

Using Microsoft Access Database will enable you to:
Understand what a database is and become
familiar with the layout of a database screen.
Create, close, open, make corrections,
print and save a database.
Sort a database and extract information
from it.
Understand the difference between
a database form and a report.

Getting the
most out of
this booklet

You may want to work your way through the booklet
from start to finish or focus on an area of interest.
Once you have completed the questionnaire on
page 4 you will be able to see clearly which topics
you need most help with, and which areas you can
safely leave out.
You may want to ask your supervisor or another
colleague for their views on the areas you could work
on, or for help with the activities in the booklet.
As you may want to use the booklet for future
reference, you may want to write the answers out
in rough first and then write them in the booklet.

USING MICROSOFT ACCESS DATABASE. LEARNING FOR WORK Series. © Workbase Training
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Questionnaire
What do you
need most
help with?

This questionnaire is to enable you to think about
which areas of database skills you need most help with.
Tick boxes as appropriate.

1

2

3

I need a
lot of help.

I need
some help.

I can cope.

SECTION 1: What databases can
be used for
SECTION 2: Understanding the
layout of a database screen
Understanding what the different
picture symbols on the screen do
SECTION 3: Creating a new
database
Making corrections
to a database
Knowing what to do when
I make a mistake
Saving a database

Closing a database

Opening a database

SECTION 4: Sorting a
database
Searching a database for
specific information
SECTION 5: Working in database
form view
Creating a database
report

The most important areas for you to concentrate on
are those which you have marked 1 or 2.

4

USING MICROSOFT ACCESS DATABASE. LEARNING FOR WORK Series. © Workbase Training

Section1
What is a
database?

UNDERSTANDING
DATABASES
A database is used for storing a lot of similar information
in an organised way using a computer and a database
program like Microsoft Access or Lotus Approach.
A telephone directory is a good example of a database.
It contains a very long list of names, addresses and
telephone numbers organised in a structured way and
sorted in alphabetical order of surname. A database is
used for storing lists that you may handwrite in everyday
and business life. A database can be used to store
personal and business address details, employee details,
customer and supplier records and sales or product
information. A database can save time by storing the
information for you.
Not only can you store vast amounts of information in
a database, but also it is designed to allow you to
manipulate the information stored in various ways.
You can:

• make changes to details
• add and remove details from a database list
• sort the information in various ways, e.g. sort by
Surname and sort by City

• search through the database to extract specific
information, e.g. all who live in the City of London
and everyone with a surname beginning with ‘S’
• save all the different versions of sorted and specific
extracted information and still leave the original
database list intact
• work in a form view seeing one record at a time
rather than all records
• create and print various reports from data contained
within a database.
A database can be used in many ways, from very simple
to very complex. Essentially, you store and manipulate
information contained in a database.
Tables are the heart or central storage place for
information in a database. Tables are organised in a
column and row format. You design a table by deciding
on the column headings you wish to use, then record
the individual details along a row.

USING MICROSOFT ACCESS DATABASE. LEARNING FOR WORK Series. © Workbase Training
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Fields – column headings
Surname

Forename

Address1

Address2

City

Postcode

Tel No

Broomley

Alison

1 The Broadway

Finchley

London

N12 0BL

020 7959 0230

Smith

David

Flat 5

The Warren

Birmingham

B16 0PP

0121 733 2401

Daley

Monica

22 Ganson St

Walthamstow

London

E17 9AB

020 8521 6784

Warner

James

15 Morden Lane

Harrow

Middx.

HA8 8LA

020 8842 3363

Toussaint

Marilyn

8 The Close

Selinas Road

Sydenham

SE27 4DL

020 8290 7059

Smith

Simon

333 High Road

Colchester

Essex

1DB 6CO

01708 231 478

Records – in rows showing
each individual’s details

Fig.1 Database table layout
Tables can accommodate hundreds of records and many
field headings. To make a database more manageable, a
database table should not contain too many field
headings. Too many field headings can make a database
difficult to navigate through as you will not be able to see
the whole table across the screen. To overcome this, more
than one table can be created in a database. Tables of
related information can then be linked to display the
information in two or more tables when required.
Databases are therefore referred to as relational databases,
as you can relate to more than one table by linking
them within a database. For example, if you wanted to
maintain an employee details database, you could have
one table for names and telephone numbers. Another
table could be created for other information like job
title, department, manager. PAYE information could be
kept in another table.
Once you have all your information in tables, you can
then manipulate the database in various ways.
Part of getting used to databases will be to understand
some of the words that are used to describe features that
you will use. A list of common words with explanations
has been included at the end of this booklet.
Databases contain different views and objects that can
be used. Using a computer to produce databases is
easier if you understand the different objects that are
available and what they are used for. You may never use
all the features and functions available in a database
but it is good to know the aspects you will use and not
be confused by the rest! Once you have learned the
basic skills, you can then go on to master some more
advanced skills if you wish. Learning a bit at a time is the

6
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best way to get the most out of developing your skills
using a computer spreadsheet package. Improvement
will come with practice! As you practise working with
databases, it will save time and can be enjoyable to
create something of your own.
Different database programs may work slightly
differently but essentially they perform similar tasks.
Microsoft Access database is used for most examples.

Activity1

Define what a database package is
1. A database is

2. You can use a database package for

You will find the feedback to
this activity on page 31.

Key
Learning
Points

Databases are used for storing large amounts of
information in an organised way.
Database information is stored in a table arranged
in column and row format.
Once created, a database can be manipulated and
changed in various ways.
You can sort and search for extracts of information
contained in a database.

USING MICROSOFT ACCESS DATABASE. LEARNING FOR WORK Series. © Workbase Training

7

Section2
Different parts
of a database
program

OBJECTS SEEN IN A
DATABASE PROGRAM
To get the best use out of databases, it is helpful to
know what the different parts of a database are used
for. Database objects are icons or options you can use
to do different things within the database. The objects
in a database are linked in that they all use the same
information but some allow you to enter information
and some objects allow you to manipulate and present
database information. Objects are useful and give you
choices as to how you use and manipulate a database.
Different programs display database objects in different
ways. Even though the database screens may look a little
different, the programs essentially try to achieve the
same activities and outcomes.

Objects

Databases contain objects that can be used to achieve
different outcomes using the same information.

Tables

Tables are the starting point for a database, where the
structure for the database is designed. You design a
database table by deciding on the headings to use for
columns. Once the headings are designed, records are
entered along a row under the appropriate heading.

Fig. 2 Database Table

Forms

8

Information can also be entered in Form view. Form
view allows you to type in boxes rather than in cells
along a row. You can design a form to display one
record at a time or all records. A form uses data from a
table. You therefore see the same information whether
you are in form view or table view. You choose the view
that you prefer to work with.

USING MICROSOFT ACCESS DATABASE. LEARNING FOR WORK Series. © Workbase Training

Fig.3 Database Form in column view

Fig.4 Database Form in tabular view

Queries

Queries are used to sort, search and perform calculations
on information contained within a table whilst the table
remains intact. Using a query is like taking a copy of the
table to manipulate in various ways. You can save each
query created. For example, you can search for all who
live in London and create another search for all whose
surname begins with ‘S’. Queries look like a table but
contain the extracted information.

Fig.5 Database Query search results for London addresses

Fig. 6 Database Query search result for surnames
beginning with ‘S’
USING MICROSOFT ACCESS DATABASE. LEARNING FOR WORK Series. © Workbase Training
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Reports

Reports are used for printing information contained in
a table, query or form. A report allows you to choose
different styles of presentation. You can also create
summary and grouping of information from a table,
query or form.

Fig. 7 Database Report using the table information –
report has been sorted by surname
Databases are very flexible and can save time. The
information is typed into a database once and, whether
you use a form, query or report, all the data can be
saved and printed, keeping the original table intact.

Key
Learning
Points

Databases use objects to allow you to view and
present the database in various ways.
The most common objects are tables, forms,
queries and reports.
All objects use or borrow the information
contained within a table whilst keeping the table
intact.
You can choose which view you prefer to use – a
table or a form.
A query is used to sort and search for information
contained within a table.
Reports allow you to manipulate the table further
and choose a style for printing the database.

10
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Section3
How to create
the database
structure

CREATING AND CHANGING A
DATABASE STRUCTURE
Creating a database structure includes deciding on
headings to use and how you may wish to manipulate
the database in terms of sorting the data and searching
for specific information contained within the database.
In order to sort or search the database efficiently, it is
better not to hold too much data under a field heading.
For example, a separate field for Surname and First name
will make it easier to sort and search by surname or first
name. An address can be split into two or three headings,
as you would address an envelope, using a different field
for each line of the address and the postcode. (See fig. 1).
When sorting and searching, the database recognises the
first letter or character in each field cell. If all information
is placed under one address field and you wish to
search for addresses in London, because London is not
the first word in the field, the database would not be
able to extract that information.

Data Types

As well as listing the headings, you will also have to
decide on a Data Type. The data type indicates the type
of data that will be held under a field heading. For
example, you can choose a Date data type if you were
working with dates. The database will recognise that
the data under the field consists of dates only. Choosing
a data type keeps the data under a field heading
consistent, and assists the database with sorting,
searching and performing calculations on a field.

Data Type Examples

Description

Text

For letters and numbers that are not dates or numbers that do not
require calculation. The field can contain up to 255 characters and can
include spaces.

Memo

For lengthy text, e.g. notes and comments. Can contain up to 64,000
characters.

Number

For numbers.

Date/time

For using, sorting and searching for dates and/or time.

Currency

For working with money.

AutoNumber

Creates a number and follows with the next consecutive number to
number entries automatically in a field.

Yes/No

Use when only two variables apply, e.g. Yes/No, On/Off, True/False.

USING MICROSOFT ACCESS DATABASE. LEARNING FOR WORK Series. © Workbase Training
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Field headings

The first step in creating a database structure is to design
and list the field headings. Once all the field headings and
data types have been entered and saved, you will be ready
to record the details under the relevant field heading.
1. From the File menu, select New database.
2. Save the database.
3. Select Table.
4. Go to Design View to create the heading structure.
5. List headings you wish to use under Field Name.
6. For each field, select a Data Type.
7. Optional: decide what the maximum number of
characters will be in each field and enter in Field
Size in the Field Properties section – you can adjust
the width of columns after creating the database.
8. Click on OK or switch to Datasheet View toolbar
icon when headings list is complete.

(Note: Datasheet View
may also be referred
to as ‘Browse’ View.)

Field Name:
list headings to be
used in database.

Data Type:
click in the cell to
the right of the
heading. Click on
the triangle and
select a data type
that relates to the
heading.

Field
Property: allows
you to fine tune
how data under a
field heading will
appear. Click with
mouse white
box.

12

9. Save the table structure you have just created.
10. Switch to Datasheet View to see the headings
across the top of the screen.
11. You will now be ready to start entering the records
under the heading names.
Description:
enter text for a
description if the
heading name is
not explanatory or
if you want to
make a note about
the heading or
content.
Field Size:
enter a number
for the maximum
length of
characters for
a field –
optional.
Description:
wherever the
cursor is placed –
provides a
description for
the section, e.g.
the cursor is in
data type.

Fig.8 Database Table Design View – to create headings for table

USING MICROSOFT ACCESS DATABASE. LEARNING FOR WORK Series. © Workbase Training

Field properties

Entering data
in a database
table

Field properties allow you to further fine tune how you
wish a field to be used. You can set the maximum
characters to be held under a field by changing the
field size number. You can choose a format for
displaying, for example, numbers and dates. A date
can be displayed as a short (01/01/00) or long date
(1 January 2000). Placing the cursor within any field
property will display help text on how the field
property is used.

Once you have:

• created your database field headings
• saved the structure
• switched to Datasheet View,
you will be presented with your table to start entering
records. The headings listed in Design View now appear
across the first grey shaded row of the table.

• The white area is where you start recording the
details under the correct headings.
• As soon as you begin to type in details along the row,
another row will appear ready for the next record
details to be entered.
• To move to the next cell under a heading, use the
mouse to click into the next cell.
• Records typed into a database table are saved
automatically.
Note: Record details can be entered only in the next
available row at the bottom of a table. You cannot
insert rows within a table.

Start
entering record
details here.

Record counter

Fig.9 Database Table Datasheet View – to enter record
details in table

At the bottom of a table, there is a record counter that
displays the number of records in the table. The record
counter enables you to manage the table by displaying
the number of current records and the total number of
records in the table. You can also move to different records
by using the triangles to move back and forward
through the records in the table.

USING MICROSOFT ACCESS DATABASE. LEARNING FOR WORK Series. © Workbase Training
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Move
to previous
record.

Current record
– row where cursor
is positioned.

Move to
the Last record
in the table.
Total
number of
records in
table.

Move to the First
record in the table.

Move to
Next record.

New record, the last
blank row in the table.

Fig.10 Database Table Record Counter – use to move
through records

Making
changes to a
database table

You can edit and make changes to the database table in
various ways. You can add new headings and remove
unwanted headings. Additional records can be added
to the table. Records no longer required can be
deleted and corrections can be made.
Inserting a new field heading:
1. Place the cursor in the column where the new
column will go.
2. From the Insert menu option, select Column. A blank
column will appear on the screen.
3. To rename the column, click on the Format menu
and select Rename Column. Type in the new column
heading name.
Deleting a column heading:
1. Place the cursor in the column to be deleted.
2. From the Edit menu option, select Delete Column.
The column will disappear from the screen.
You can also go back to design view to insert and
delete columns by adding or deleting heading names
from the list.
Adding a new record:
New record details must be added in the blank row
after the last row.
Deleting a record:
Select the row to be deleted by clicking on the grey
area at the beginning of the row. Press the Delete key
on the keyboard.
Making changes to record details:
Place the cursor within the cell to be amended and
make the required changes to the text.

14
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Working with more
than one table

You can create more than one table in a database. This
can make it easier to manage a lot of data. For example,
a database containing employee details may contain
the following information – personal details, salary
details, work department and manager details. Rather
than using one table for all these details, separate
tables that group the relevant information together
can be created so that you can work with one table at a
time rather than having to navigate through a table
that contains a large number of headings and details.
Tables in a database can be linked to combine data from
more than one table so that you can see the contents of
more than one table at a time. This makes the database
more manageable as each table is not too large, and
you can work with the tables you need. Tables can be
combined and viewed in various ways – for example, if
you wish to look at personal details and salary details,
the tables can be linked and viewed together for that
purpose.

Using preset
databases

Alternatively, you can use a wizard or smartmaster from
the list available in the database program from File and
New. A wizard is a helper that guides you step by step
through the process of creating a database. You would
choose a database similar to the one you would like to
create and make modifications during the creation
process to fine tune the preset wizard to the structure
you want to create. For example, you may or may not
see the exact category you require for your address
book but you can choose one that is similar, like the
suppliers category, that would contain the structure
for names and addresses.

Save, close, open
and print functions

Saving a database table: Records typed into a database
table are saved automatically. Creating and making
changes to the field heading structure of a database
are saved manually. You will be prompted to save
changes when you create or make changes to the
database table structure.
Closing a database: To close a database table, click once
on File and select Close from the menu options. You
can also use the X in the top right-hand corner of the
table. Remember that a table is contained within the
main database. After closing the table, you will need
to close the database main window when you have
finished working with the database.
Opening an existing database: Click once on File and
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select Open from the menu options. Select the database
to be opened. Remember that the database name will
be different from the table name contained within the
database.
Printing a database table: Click once on File and Print
from the menu options whilst the table is displayed on
the screen.

Activity2

1. Which character in a field heading does a database
recognise?
(a) Any character in a field heading
(b) The first character in a field heading
(c) The database does not recognise characters
2. Why is the database structure important?
(a) The database structure is not important
(b) To make the database look presentable
(c) To make it easier to sort and search the database
3. What does a wizard do?
(a) Perform magic
(b) Guide the process of creating a database
(c) Make the database look presentable
4. Which data type would you use if you were entering
dates of birth?

You will find the feedback to
this activity on page 31.

Activity3

(a) Text
(b) Memo
(c) Number
(d) Date

List the headings you would use to keep details of
personal or business contacts in a database:

You will find the feedback to
this activity on page 31.

16
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Activity4

Create the following database table:

Surname

Forename

Address1

Address2

City

Postcode Tel No

Broomley

Alison

1 The Broadway

Finchley

London

N12 0BL

020 7959 0230

Smith

David

Flat 5

The Warren

Birmingham B16 0PP

0121 733 2401

Daley

Monica

22 Ganson St

Walthamstow London

E17 9AB

020 8521 6784

Warner

James

15 Morden Lane

Harrow

Middx

HA8 8LA

020 8842 3363

Toussaint

Marilyn

8 The Close

Selinas Road

Sydenham

SE27 4DL

020 8290 7059

Smith

Simon

333 High Road

Colchester

Essex

1DB 6CO

01708 231 478

There is no feedback
to this activity.

Key
Learning
Points

To create a database structure, you need to think
about the headings you wish to use in a database
and how you may want to manipulate it.
Headings are listed in design view when creating a
database table structure and record details are
entered in datasheet view.
Record details can only be entered in the next
available row at the bottom of a table. You cannot
insert rows within a table.
You can make various changes to the database
table. You can insert and delete columns and rows
as well as make changes to the data in the table.
There are predefined databases in the program
where you are given help to create the database,
e.g. a wizard.
If the database consists of many headings, more
than one table can be created.
A table is an object that is contained within the
main database.
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Section4
Sorting
Sorting a
database table

SORTING AND SEARCHING
FOR SPECIFIC RECORDS
Databases are flexible and can be sorted in various
ways. A database can be sorted from table, query, form
or report.
From the database table, records can be sorted
temporarily using A–Z on the toolbar or permanently
using a primary key.
1. Use A–Z key to sort by ensuring your cursor is
positioned in a cell under the heading you wish to
sort from. Click once on the A–Z toolbar icon to sort
in alphabetical order. The table will now be sorted in
the order chosen.

Sort toolbar icon
Tables can only be sorted by one heading at a time.
You can view the various sorts immediately in a table.
You may also want to bring the table back to its
original order.
You can also unsort the table by clicking on the
Records menu option and choosing Remove sort
from the list of options. The table will now be back to
its original order.
A query can be used to sort a table and the different
sort versions can be saved for future reference.
Queries will be explained on page 20.
2. Attach a primary key to the field heading by which
the table will always be sorted to allow permanent,
automatic sorting by specified field heading.
Note: when using a primary key, the field cannot contain
any duplicate names, e.g. if Smith appears twice
under the heading, a primary key cannot be used.

Primary key toolbar icon

18
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To attach a primary key to a field heading:

• go back to design view of the table
• position the cursor in the cell containing the heading
•
•
•
•

Searching for
specific records
Extracting records
within a table

for the table to be permanently sorted
click once on the primary key toolbar icon
the key icon symbol will appear to the left of the
selected heading
save the change to the database table structure
switch to datasheet view and the records under the
heading containing the primary key will be sorted.

Once a database is created and all the records entered,
you may want to find a specific record or range of
records that meet a particular criterion. For example,
you may want to find all records with the surname
beginning with ‘S’. A database can be used to extract
specific records from a table in various ways.
Records can be extracted from within a table either by
using Find to look for a specific record or by using a
filter to extract records that meet a particular criterion.
Using the Find feature
Find allows you to specify a word you are looking for by
typing a word that is equal to it in the Find What box
whilst the database table is still on the screen.
Position the cursor within the field where the data will
be found, e.g. Surname. Select the Find toolbar icon to
view the Find dialogue box. Type the word you are
trying to find in the Find What box. Click once on Find
Next. You will then see the found word highlighted in
the background on the database table. Once you have
found the word for the record you were seeking, click
once on cancel to close the find dialogue box.

Find toolbar icon
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Click
on Find
Next to
locate the
word in
the table.

Type
the word
to be
found
here.

Click
on Cancel
once the
word has
been
found.

Fig. 11 Find dialogue box
Using a Filter to extract specific records
Filtering allows you to find records within a table. To
search for addresses in London, position the cursor
within a cell that has the word London in it and click
once on Filter by selection. All London addresses will
be displayed.
To remove the filter and return to the original table,
click once on the Remove filter icon.

Filter by selection

Extracting records
using a query

Remove filter

A query can be used to extract specific information
from a database table. Records can also be sorted using
a query. Extracted information can be saved and used
for future reference. As the table is updated, the query
is also updated. Queries are constructed in design view
and the result viewed in datasheet view.
A query is quite versatile and can be used to extract:

• a specific record
– type in record detail under a relevant field heading

• a range of records
– e.g. all those who live in ‘London’

• values
– e.g. less than, greater than, equal to

• more than one criterion
– e.g. those living in ‘London’ with surname
beginning with ‘B’.
A query can also be used to sort records.

20
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A query window displays rows containing the following
details:
Row heading

Description

Field

Drag field headings to each cell along this row.

Table

Table name will automatically be displayed here.

Sort

Click under the required heading, along the sort row and choose
ascending or descending order sort.

Show

A 4 indicates that the heading will be displayed after completing the
query. No 4 means the heading will be hidden.

Criteria

Used to type in specifically what is being searched for, e.g. London.

Or

In a query you can search for something or something else, e.g. London
or Middx.
To create a query:
• select Query from the database main window
• select the table to be queried
• drag fields to next available cell on the field row
• to sort – click under correct field heading along the
sort row and choose ascending or descending order
• to show or hide field headings – to display a field
heading, the 4 should remain under the relevant
field headings along the show row. To hide a field
heading, click on the relevant 4 to remove it. The
heading will not be displayed
• criteria is used for specific extracts, e.g. London. Type
in what you are searching for
• the query can be saved with a relevant name for
future reference.
As the table is updated, the query will also be updated.

Fig. 12 Query window in design view
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To view the query result, switch to datasheet view.

Fig. 13 ‘London’ query result in datasheet view
Note: If the query does not return the correct result,
go back to design view and check details typed in to
ensure they are correct. Details typed in criteria must
be the same as they appear in the table. A query can
only find what appears in the table.
A query ‘borrows’ the table details. The original table
will remain intact.

Search operators

To assist with queries, common search operators can
be used for criteria as follows:
Wildcards

Code

Description

Example

*

Asterisk* can be used in place
of any following characters

S* finds records in the field that begin with
‘S’ and end with anything, e.g. Smith

?

Question mark? Represents
any single character

H?ll finds any 4 letter records that begin with
the letter ‘H’ and end with ‘ll’. The second
character can be any letter, e.g. Hall, Hill, Hull

Search operators for values
Code

Description

Example

>
<
<=
>=
<>

Greater than

> 2 finds values more than 2
< 2 finds values less than 2
<= 2 find values of 2 or less
>= 2 find values of 2 or more
<> 2 find values that are not 2

Less than
Less than or equal to
Greater than or equal to
Not equal

Selection operators
Code

Description

Example

Between

To select a range of numbers or dates

Between 10 and 20

Like

To find similar records using wildcards

Like S*

22
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Queries are very useful when searching for simple
and/or complex extracts from a database table. As
queries can also be saved, you will always have a copy
of the table in the various forms you require.

Activity5

Example: To search for addresses in London, how would
details be entered in a query?
Field

City

Table
Sort
Show
Criteria

London

Or
1. To search for addresses in Essex, where would you
enter the details?
Field
Table
Sort
Show
Criteria
Or
2. To search for anyone with a surname beginning with
‘W’, where would you enter the details?
Field
Table
Sort
Show
Criteria
You will find the feedback to
this activity on page 31.

Or
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Key
Learning
Points

Database tables can be sorted using a table
or query.
A query is used to extract specific records from a
database table.
Tables can be sorted permanently using a
primary key if the heading does not contain
duplicate names.
Find and filter can be used to extract records
within a table.
Queries are constructed in design view and the
result viewed in datasheet view.
Queries ‘borrow’ and use a copy of the original
table. The original table remains intact.
Queries can be saved for future use.

As the table is updated, any query containing the
same details will also be updated.

24
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Section5

USING DATABASE FORMS
AND REPORTS
Database forms and reports offer alternative views of a
database table or query. A form is similar to a paper-based
form with headed boxes for entering data. A form can
be used to view a single record or multiple records in a
database. Unlike a table, a form can be laid out in a clearer,
customised, user-friendly way and can also be printed.
A report is not used to enter and edit data, it is used to
display data in a more presentable form. You can also
group and summarise data, as well as perform calculations
in a report, using data from a table, query or form.

Working with
database
forms

Working with forms, you can use a wizard to assist you in
creating an auto form to display the type of form layout
required (See figs 3 and 4). Select the Form object and New
Form to begin creating a form. Select the type of form
required and choose the table or query to be displayed.
Select
form
type.

Select
the table or
query to be
used in the
form.

Fig. 14 Database New Form dialogue box

Form types
Form type

Description

Design view

Create your own layout for a form in design view

Form wizard

Step-by-step guide to create a form

AutoForm: Columnar

Single record displayed with headings on the left and detail
boxes on the right

AutoForm: Tabular

Records displayed similar to a table

AutoForm: Datasheet

Very similar to a table

Chart Wizard

Step-by-step guide to create a graph

Pivot Table Wizard

Table that allows you to summarise and analyse data in different ways
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Form design

Once the form layout is displayed showing the records
that were contained in the database table or query, you
can manipulate the form and change the layout as
preferred. For example, all of a record may not be
displayed. Some text may be hidden if the box is too
small to display all of the record content. Similarly, the
record to be held in the box may contain only a small
number of letters or numbers so the box may be too
large for the type of record. To change the layout of a
form, you can work in ‘Form Design View’ to:

• insert a heading in the Form Header section
• insert details in the Form Footer section, e.g. page
numbers
• increase or decrease the size of the heading or detail
boxes
• move boxes and place them where you want them to
appear on a page.
Forms consist of Labels representing box headings and
Text boxes that contain the record details. Record
details can be entered and edited in the text box. Text
is aligned on the left-hand side of a box and numbers
are aligned from the right-hand side of the box.
Label
Heading

Form
Header
section.

Text box
Record details
To extend form
background, point to
white edge until a double
black arrow appears and
drag to required width.

Selected
boxes
have black
boxes
around
the edges.

Form
Footer
section.
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Add
field
box.

Fig. 15 Columnar form in design view
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Form ‘design
view’ layout

Form design view is divided into three sections:

Form Header

Where you can type your own heading for the form

Details

Labels and text boxes for headings and record details

Form Footer

Enter details at the bottom of the form page

Moving and resizing
labels and text boxes

To extend the background of a form:
Point to the edge of the white right section of the
form. When a double-edged black arrow appears,
drag the white background to the desired width. When
moving form boxes, they must be placed on the white
section.
To select text boxes and labels:
Point to a label or text box and click once with the
mouse. Black boxes will appear around the edges of the
label and/or text box. Both label and text box will be
selected. Once selected, the boxes can be moved and
resized.
To move label and box together:
Select a box to highlight both label and text box. Move
mouse pointer around the box until a hand appears
.
Drag boxes to the desired location.
To move either label or text box:
Select the relevant box. Point to the top left black box
on the box to be moved until a hand with the index
finger extended appears . Drag the single box to the
desired location
To resize a label or text box:
Select the required box. On the right edge of the box,
three selection boxes should be displayed. Point to the
middle selection box until a double-edged black arrow
appears
. Drag to extend or reduce the size of the
box.
Moving and resizing boxes takes a little practice. Don’t
be afraid to try. If you make a mistake, use the undo
toolbar icon immediately. The undo icon cancels the
last thing you did.

Undo toolbar icon
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Inserting main
headings and
footer details

Use the toolbox to add special features to a database form.
For example, Aa is used for adding text or numbers to the
header and footer areas. Click on Aa. Click on the form
where text will be placed and type the text required.

Aa is for
adding text to
a form.

Form design
view toolbox
To create a form heading:
Create space for a heading by pointing to the bottom
edge of the Form Header section until the mouse
pointer displays the resizing tool ll . Drag
downwards to create space for a heading. Click on Aa
on the toolbox, click on the form background where the
heading is to appear and start typing the heading text.
To create a form footer:
Click on Aa in the toolbox, click on the form background
where the footer is to appear and start typing the
footer text.

Working with
database
reports

Reports are used to display database tables, queries
and forms in a presentable format. You can create a
report using the report object. Select a new report and
the table, query or form to be displayed as a report.
You can choose an auto report or use a wizard to guide
you through creating your report. Follow the steps
using the wizard and click on Next once you have made
your selections.
Using a wizard, you can choose:
• the field headings to be displayed in the report
• to group similar details, e.g. all London addresses
• to sort the report by a particular field
• a predefined layout from a list for your report
• a fancy or plain background, e.g. grey background
• a title for your report.

28
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The report will be displayed with all details from the
table, query or form chosen (see fig. 7). Included in a
report footer are page numbers and the current date.

Report views

To modify your report design
Report as it will be printed
Sample of records in your report

Modifying a
database report

Once you have created a report, changes can be made
to the layout of the boxes in much the same way as you
would modify a form. To change the layout of a report,
you can use ‘Report Design View’ to:

• insert a heading in the Report Header section
• insert details in the Report Footer section, e.g. page
numbers
• increase or decrease the size of the heading or detail
boxes
• move boxes and place them where you want them to
appear on a page.
Reports consist of Labels representing box Headings
and Text boxes that contain the record details.

Fig.16 Report design view layout
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Report design view is divided into three sections:
Section

Description

Report Header

Where you can type your own heading for the report.

Page Header

Where the field heading labels are placed – the heading will then
appear only at the top of each page.

Details

Labels and text boxes for headings and record details.

Report Footer

Enter details at the bottom of the report page. The date and
page numbers are displayed here.
=Now() is the code for the date.
=”Page” is the code for page numbering.
To move and resize labels and text boxes and include
header and footer details, follow the steps for
modifying forms above. You can also use the toolbox to
add text to your report.

Activity6

1. Create a columnar auto form.
2. Switch to form design view and modify the design
layout.

Activity7

1. Create an auto report.
2. Create a report using the report wizard.
3. Switch to design view and modify the report design
layout.

There is no feedback
to these activities.

Key
Learning
Points

Database tables can be viewed as forms
or reports.
Several different form layouts are available.

In a form, text can be entered and changed, using
‘Form Design View’.
The purpose of a report is to display data in a
presentable form.
The layout of a report can be modified to make it
easier to understand.
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FeedBack

toActivities

FEEDBACK TO ACTIVITY 1
1. A database package is – a program for storing a lot of
similar information in an organised way.
2. You can use a database package for:
• a personal telephone & address book
• customer/supplier details
• employee records
• contacts details
• information on key organisations
• technical terms
• market data, and others
FEEDBACK TO ACTIVITY 2
1. (b) The first character in a field
2. (c) To make it easier to sort and search the database
3. (b) Guide the process of creating a database
4. (d) Date
FEEDBACK TO ACTIVITY 3
• Surname
• First name
• Job title
• Company name
• Address1
• Address2

•
•
•
•
•
•

City
Postcode
Tel No.
Fax No.
Mobile No.
E-mail address

FEEDBACK TO ACTIVITY 5
1.

Field

City

Table
Sort
Show
Criteria

Essex

Or

2.

Field

Surname

Table
Sort
Show
Criteria

W*

Or
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Glossary

of terms used
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Browse

View for entering and editing data using
Lotus Approach.

Cancel

Click on cancel if a dialogue box appears
that you do not wish to use.

Cell

Boxed typing area in a database table. Click
with the mouse to type within the cell.

Close

Remove a database from the screen by
closing it. Select ‘Close’ from the ‘File’ menu.

Criteria

What you search for using a database
query, e.g. London addresses. Type ‘London’
in the criteria row under the ‘City’ heading
in a query.

Cursor

Flashing symbol within a database cell. Text
typed will appear where the cursor is
flashing. You can move the cursor by using
the mouse to point and click where you
want the cursor to be placed.

Data type

The type of data that will be contained
under a field heading, e.g. date data type
can be used for dates, and text data type
can be used for words. This makes it easier
to sort a database.

Database

A collection of records stored in an organised
way. Field headings are designed and
record details are entered under each field.
You can sort and search records using a
database.

Delete

Remove letters or words by using the
backspace or delete keys on the keyboard.

Dialogue
box

A box that appears when some toolbar
icons or menu options are used.

Datasheet
view

This view is used to enter and edit record
details. Datasheet view is also to view the
result of a query.

Design
view

Used to set up the database structure.
The structure consists of listing headings
to be used in the database.

Edit

Make changes to a typed database. You can
insert and delete letters or words in a database table cell.
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Enter

The enter key on the keyboard moves the
cursor to the next cell in the database
table or form.

Field
heading

Heading created when designing a
database structure.

File

A database object including its tables,
queries, forms and reports.

Filename

The name given to a database when it is
saved. You will look for the filename when
you wish to open the database.

Filter

Select a record to view all entries with the
same data within a cell, e.g. select
’London’ to view all cells containing
‘London’ within that field.

Find

Search for a word/number within a
specified field column.

Folder

Storage area for a database. Usually yellow
and is the computerised version of a
paper folder that databases are stored in.

Form

Alternative view of a database table
consisting of headings and boxes to type
into. You can enter, edit and print data
using a form.

Formatting

Changing the look of a database, e.g.
making some text stand out.

Functions

Different options that can be selected
from the toolbar icons or menu options,
e.g. print. Sometimes also called options.

Highlighting See Selecting.
Icons

Picture symbols used to activate different
functions, e.g. Print.

Insert

Add letters or words anywhere in a database
table, query or form by positioning the
cursor where the insertion is to appear.

Label

A database field heading box displayed in
design view.

Layout

How text is presented on a page, e.g.
spacing used, centring.
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Line spaces

Extra space inserted between lines of
typed text.

Menu
options

Grey bar near the top of the screen that
starts with the word File and ends with
Help. Clicking on any word brings down a
list of different functions that can be used.

Objects

Different icons you can use to carry out
specific functions. Table, query, form and
report are different database objects.

OK

After choosing options in a dialogue box,
click on OK to accept the options.

Open

Retrieve a file stored in the computer and
display it on the screen.

Options

Alternative word for functions (see
Functions).

Page

Alternative word for a database or file
(see Database).

Paste

To place text that has been cut or copied.
Ensure the cursor is in the position where
text is to be placed before clicking on the
paste icon.

Primary
key

Used for sorting records automatically in
a database. In design view, select the field
heading that the table will be sorted by,
e.g. surname, and click on the primary key
toolbar icon.

Print

Produce a copy of a database on a sheet
of paper (hard copy).

Query

Use a query to extract records that meet
a specified criteria, e.g. type ‘London’ in
the criteria row under the ‘City’ heading
in a query to display London records on
the screen only. Queries can also be used
for calculations.

Records

Each line of detail in a database.

Report

Alternative view of a database. Useful for
presenting data. You can also sort, group
and carry out calculations using a report.
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Save

To store a database on the computer for
future reference.

Scroll
bar

Grey bar with a black triangle at each end
that allows you to move up and down or left
to right to see the parts of the page that are
hidden from view.

Search

Type a word using Find or a query to find
and display records on the screen that meet
the specified criteria.

Selecting Highlighting by dragging over a selection of
words or letters until they are all black.
Selecting is used when you wish to carry out
a function on the selected area only.
Show

Allows you to decide which columns are to be
displayed and which columns are to be hidden.

Sort

Sort records in ascending (A–Z) or descending
(Z–A) order by field heading.

Spell
check

Database packages contain a dictionary
that checks the spelling of words. Click on
the ‘ABC’ toolbar icon.

Table

A chart consisting of columns containing
field headings and rows that contain
individual record details. You can sort and
find records in a table.

Text box

A box containing record details in database
design view.

Text
enhancements

Making text stand out by using bold,
italic and underline.

Toolbar

A row of picture symbols along a grey bar
that represent different functions that are
available for your use.

Toolbar
icons

Each picture on a toolbar is known as an
icon.

Toolbox

Box with different icons that can be used to
modify a database.

Undo

Used to cancel the last action – click on
undo immediately after you make a mistake
to cancel the last action.

USING MICROSOFT ACCESS DATABASE. LEARNING FOR WORK Series. © Workbase Training

35

Do you:
Wish that you were able to understand and
use databases?
Panic when you are asked to prepare tables
on the computer?
Worry that you will delete the information
on the database if you have to make a change?
Want to know how to store information, create a
database and make changes if necessary?
If you answered ‘Yes’ to one or more of these
questions, you will find that the activities in this
booklet will help you with the following:

•
•
•
•

WORKBASE TRAINING
Finchley House Business Centre
707 High Road
Finchley
London N12 0BT

understand what a database is
create and change databases
extract and print information from a database
explain some of the common words used.
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